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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Computer models
equipped with an
AMD processor

Product Name

HP Pavilion g7 Notebook PC

√

Processors

AMD Fusion E-450 1.65-GHz processor
(dual core, 18 W)

√

AMD A8-3500M 2.40-GHz processor (1.5GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

√

AMD A6-3400M 2.30-GHz processor (1.4GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

√

AMD A4-3300M 2.50-GHz processor (1.9GHz FSB, 4.0-MB L2 cache, dual core, 35 W)

√

AMD Athlon II P360 2.30-GHz processor
(1.0-MB L2 cache, 1066-MHz, 3.2GT/sec,
dual core, 25 W)

√

AMD Athlon II P340 2.20-GHz processor
(1.0-MB L2 cache, 1066-MHz, 3.2GT/sec,
dual core, 25 W)

√

AMD Phenom II N870 2.30-GHz processor
(1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W)

√

AMD Phenom II N970 2.20-GHz processor
(2.0-MB L2 cache, 1333-MHz, 3.6GT/sec,
quad core, 35 W)

√

AMD Phenom II P860 2.00-GHz processor
(1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 25 W)

√

AMD Phenom II N660 3.00-GHz processor
(2.0-MB L2 cache, 1333-MHz, 3.6GT/sec,
dual core, 35 W)

√

AMD Phenom II N850 2.20-GHz processor
(1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W)

√

Computer models
equipped with an
Intel processor
√

1

Category

2

Description

Computer models
equipped with an
AMD processor

AMD Phenom II P650 2.60-GHz processor
(2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
triple core, 25 W)

√

AMD Phenom II P960 1.80-GHz processor
(2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
quad core, 25 W)

√

AMD Turion II P560 2.50-GHz processor
(2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
dual core, 25 W)

√

AMD V160 2.40-GHz processor (512-KB
L2 cache, 1066-MHz 3.2-GT/sec,
single core, 25 W)

√

AMD V140 2.30-GHz processor (512-KB
L2 cache, 1066-MHz 3.2-GT/sec,
single core, 25 W)

√

Computer models
equipped with an
Intel processor

Intel Core i7-2620M 2.70-GHz (SC turbo up
to 3.40-GHz) processor (4.0-MB L3 cache,
dual core, 35 W)

√

Intel Core i5-2540M 2.60-GHz (SC turbo up
to 3.30-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

√

Intel Core i5-2520M 2.50-GHz (SC turbo up
to 3.20-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

√

Intel Core i5-2430M 2.40-GHz (SC turbo up
to 3.00-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

√

Intel Core i5-2410M 2.30-GHz (SC turbo up
to 2.90-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

√

Intel Core i5-480M 2.66-GHz (SC turbo up to
2.93-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

√

Intel Core i3-2350M 2.30-GHz processor
(3.0-MB L3 cache, dual core, 35 W)

√

Intel Core i3-2330M 2.20-GHz processor
(3.0-MB L3 cache, dual core, 35 W)

√

Intel Core i3-2310M 2.10-GHz processor
(3.0-MB L3 cache, dual core, 35 W)

√

Intel Core i3-390M 2.66-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Core i3-380M 2.53-GHz processor (3.0MB L3 cache, dual core, 35 W)

√
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Category

Chipset

Description

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

Intel Core i3-370M 2.40-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Pentium B950 TJ85 2.10-GHz processor
(2.0-MB L3 cache, dual core 35 W)

√

Intel Pentium B940 TJ85 2.00-GHz processor
(2.0-MB L3 cache, dual core 35 W)

√

Intel Pentium P6200 2.13-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Intel Pentium P6300 2.26-GHz processor (3.0MB L3 cache, dual core, 35 W)

√

Northbridge: AMD A60M Fusion
controller hub

√

Northbridge: AMD RS880MD
Southbridge: AMD SB820M
√

Intel® HM65 and HM55 Express chipset
Graphics

Internal graphics:
●

AMD Radeon™ HD 6620M graphics
supporting HD decode, DX11, and
HDMI on computer models equipped
with an AMD A8-3500M processor

●

AMD Radeon HD 6520M graphics
supporting HD decode, DX11, and
HDMI on computer models equipped
with an AMD A6-3400M processor

●

AMD Radeon HD 6480M graphics
supporting HD decode, DX11, and
HDMI on computer models equipped
with an AMD A4-3300M processor

●

AMD Radeon HD 4250 graphics
supporting DX10.1 on computer models
equipped with an AMD Athlon, Phenom,
Turion, or V-series processor

Internal graphics:
●

Intel HD Graphics 3000

●

Intel HD Graphics 100

●

Intel HD Graphics

√

√
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Category

Description

Switchable discrete graphics:
●

ATI Mobility Radeon HD 6470M with
1024-MB of discrete video memory
(128-MB × 16 DDR3 @ 900 MHz × 4
PCs), 64-bit S3 package,
muxless switchable

●

ATi Mobility Radeon HD 6470M with
512-MB of discrete video memory (64MB × 16 DDR3 @ 900 MHz × 4 PCs),
64-bit S3 package, muxless switchable

Supports DX11

Computer models
equipped with an
AMD processor
√

√

√
√

Support HD decode, DX11, and HDMI
Panel

Computer models
equipped with an
Intel processor

√

√

2 customer-accessible/upgradable memory
module slots

√

√

Supports dual-channel memory

√

√

Supports up to 8192 GB of system RAM

√

√

DDR3/1333-MHz

√

√

Supports the following configurations:

√

√

17.3-in, high-definition+ (HD+), light-emitting
diode (LED), SVA BrightView (1600×900)
display; typical brightness: 200 nits
All display assemblies include 2 wireless local
area network (WLAN) antenna cables
Supports 16:9 ultra wide aspect ratio

Memory
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●

8192-MB total system memory (4096×2;
not supported on a 32-bit
operating system)

●

6144-MB total system memory (4096×1
+ 2048×1; not supported on a 32-bit
operating system)

●

4096-MB total system memory (4096×1
or 2048×2)

●

3072-MB total system memory (2048×1
+ 1024×1)

●

2048-MB total system memory (2048×1
or 1024×2)

●

1024-MB total system memory (1024×1;
not supported on a 64-bit
operating system)
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Category

Description

Hard drives

Supports 6.35-cm (2.5-in) hard drives in
12.7-mm (.50-in), 9.5-mm (.37-in), and
7.0-mm (.28-in) thicknesses

√

√

Customer-accessible

√

√

Serial ATA

√

√

Supports the following configurations:

√

√

Fixed

√

√

Serial ATA

√

√

12.7-mm tray load

√

√

Blu-ray ROM with LightScribe DVD ±R/RW
Super Multi Double-Layer Drive

√

√

DVD±RW and CD-RW Super Multi DoubleLayer Combo Drive with LightScribe

√

√

Single digital microphone

√

√

HD audio

√

√

HP-branded Altec/Lansing speakers

√

√

Supports Microsoft Premium requirements

√

√

HP VGA webcam (fixed, no tilt with activity
LED, 640×480 by 24 frames per second

√

√

Ethernet

Integrated 10/100 network
interface card (NIC)

√

√

Wireless

Integrated wireless local area network
(WLAN) options by way of wireless module

√

√

Two WLAN antennas built into
display assembly

√

√

Optical drive

Audio and video

●

750 GB, 5400 rpm (9.5 mm)

●

640 GB, 5400 rpm (9.5 mm)

●

500 GB, 7200 and 5400 rpm (9.5 mm)

●

320 GB, 7200 (7.0 mm) and 5400 rpm
(9.5 mm)

●

250 GB, 7200 and 5400 rpm (7.0 mm)

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

5

Category

Description

Support for the following WLAN formats:
●

Broadcom 4313 802.11b/g/n 1×1
WiFi and 2070 Bluetooth 2.1+EDR
Combo adapter (BT3.0+HS ready)

●

Ralink 5390GN 802.11b/g/n 1×1
WiFi Adapter

●

Ralink RT3090BC4 802.11b/g/n 1×1
WiFi and Bluetooth 2.1+EDR Combo
Adapter (BT3.0+HS ready)

Support for the following WLAN formats:
●

Atheros 9285G 802.11b/g/n 1×1
WiFi Adapter

●

Atheros AR8002WB-1NGB 802.11b/
g/n 1×1 WiFi and Bluetooth 2.1+EDR
Combo Adapter (BT3.0+HS ready)

●

Broadcom 4313 802.11b/g/n 1×1
WiFi Adapter

●

Realtek RTL8191SE 802.11b/g/n 1×1
WiFi Adapter

●

Realtek 8188BC8 802.11a/b/g/n 2×2
WiFi and Bluetooth 3.0+HS
Combo Adapter

Computer models
equipped with an
AMD processor
√

External media
card

6

Intel Centrino Wireless-N 1000
WLAN module

●

Intel Centrino Advanced-N 6230

●

Intel Centrino Wireless-N 1000

HP Multi-Format Digital Media Reader
supports the following digital card formats:
●

Secure Digital (SD) Memory Card

●

Secure Digital High Capacity (SDHC)
Memory Card

●

Secure Digital Extended Capacity
(SDXC) Memory Card

●

MultiMediaCard (MMC)

Chapter 1 Product description

√

√

√

Support for the following WLAN formats:
●

Computer models
equipped with an
Intel processor

√

√

Category

Description

Ports

●

3-pin AC power

●

Audio-in (mono microphone)

●

Audio-out (stereo headphone)

●

HDMI version 1.4 supporting up to
1080p, 1920 ×1200 @ 60Hz and
1920 ×1200 @ 60Hz in DVI mode

●

RJ-45 (Ethernet, includes link and
activity lights)

●

USB 2.0 (3 ports)

●

VGA (Dsub 15 pin) supporting
2048×1056 external resolution @ 75
Hz, 1920 ×1200 external resolution @
60Hz, hot plug and unplug and autodetection for correct output to wideaspect vs. standard aspect video

Keyboard/
pointing devices

Power
requirements

Computer models
equipped with an
AMD processor

Computer models
equipped with an
Intel processor

√

√

Full-size, textured, pocket, keyboard with full
numeric keypad

√

√

TouchPad with multi-touch gestures, 2-finger
scrolling, and pinch-zoom enabled

√

√

Taps enabled by default

√

√

90W slim travel AC adapter with localized
cable plug support (3-wire plug with ground
pin, supports 3-pin DC connector)

√

√

√

√

√

√

65 W slim travel AC adapter with localized
cable plug support (3-wire plug with ground
pin, supports 3-pin DC connector)
Support for the following batteries:

Security

●

6-cell, 55-Whr, 2.55-Ah Li-ion battery

●

6-cell, 47-Whr, 2.20-Ah Li-ion battery

Security cable slot

√

Supports Intel AT-p Ready
Operating
system

Preinstalled:
●

Windows 7 Home Premium 64-bit

●

Windows 7 Professional 64-bit

√
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Category

Description

Computer models
equipped with an
AMD processor

√

Preinstalled:

Serviceability

8

●

Windows 7 Home Basic (64-and 32-bit)

●

Windows 7 Home Premium (64-and 32bit)

●

Windows 7 Professional (64-and 32-bit)

●

Windows 7 Starter 32-bit

●

FreeDOS

End-user replaceable parts:
●

AC adapter

●

Battery

●

Hard drive

●

Memory modules (2)

●

Optical drive

●

WLAN module

Chapter 1 Product description

Computer models
equipped with an
Intel processor

√

√

2

External component identification

9

Top
Button

Component

Description

Power button

●

When the computer is off, press the button to turn on
the computer.

●

When the computer is on, press the button briefly to
initiate Sleep.

●

When the computer is in the Sleep state, press
the button briefly to exit Sleep.

●

When the computer is in Hibernation, press
the button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold
the power button for at least 5 seconds to turn off
the computer.
To learn more about your power settings, select Start >
Control Panel > System and Security > Power
Options, or refer to the HP Notebook Reference Guide.
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Chapter 2 External component identification

Keys

Item

Component

Description

(1)

esc key

Displays system information when pressed in combination
with the fn key.

(2)

fn key

Displays system information when pressed in combination
with the esc key.

(3)

Windows logo key

Displays the Windows Start menu.

(4)

Action keys

Execute frequently used system functions.

(5)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

(6)

Integrated numeric keypad

Can be used like an external numeric keypad.

Top

11

Lights

Item

Component

Description

(1)

TouchPad light

●

Amber: the TouchPad is off.

●

Off: the TouchPad is on.

●

White: Caps lock is on.

●

Off: Caps lock is off.

●

White: the computer is on.

●

Blinking white: the computer is in the Sleep state.

●

Off: the computer is off or in Hibernation.

●

White: An integrated wireless device, such as a
WLAN device and/or a Bluetooth device, is on.

●

Amber: All wireless devices are off.

(2)

(3)

(4)

12

Caps lock light

Power light

Wireless light
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TouchPad

Item

Component

Description

(1)

TouchPad light

●

Amber: the TouchPad is off.

●

On: the TouchPad is on.

(2)

TouchPad on/off button

Turns the TouchPad on and off. Quickly double-tap
the TouchPad on/off button to turn the TouchPad on
and off.

(3)

TouchPad zone

Moves the pointer and selects or activates items on
the screen.

(4)

Left TouchPad button

Functions like the left button on an external mouse.

(5)

Right TouchPad button

Functions like the right button on an external mouse.

Top
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Display

Item

Component

Description

(1)

WLAN antennas (2)*

Send and receive wireless signals to communicate
with WLANs.

(2)

Webcam light

On: The webcam is in use.

(3)

Webcam

Records video and captures still photographs. To use
the webcam, select Start > All Programs >
CyberLink YouCam.

(4)

Internal microphone

Records sound.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, refer to the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.
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Front

Component

Description

Speakers (2)

Produce sound.

Left side

Item

Component

Description

(1)

External monitor port

Connects an external VGA monitor or projector.

(2)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during
routine operation.

(3)

RJ-45 (network) jack

Connects a network cable.

(4)

HDMI port

Connects an optional video or audio device, such as a
high-definition television, or any compatible digital or
audio component.

(5)

USB ports (2)

Connect optional USB devices.

(6)

Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(7)

Audio-out (headphone) jacks (2)

Produce sound when connected to optional powered
stereo speakers, headphones, ear buds, a headset, or
television audio.
WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and
Environmental Notices.

Front
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Item

Component

Description

(8)

Digital Media Slot

Supports the following digital card formats:
●

Secure Digital (SD) Memory Card

●

Secure Digital High Capacity (SDHC) Memory Card

●

Secure Digital Extended Capacity (SDXC)
Memory Card

●

MultiMediaCard

(9)

Drive light

Blinking white: the hard drive is being accessed.

(10)

Power light

●

White: The computer is on.

●

Blinking white: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

Right side

Item

Component

Description

(1)

Optical drive

Reads and writes to an optical disc.

(2)

Optical drive light

Blinking: The optical drive is being accessed.

(3)

Optical drive eject button

Opens the optical drive.

(4)

USB port

Connects an optional USB device.

(5)

AC adapter light

●

White: The computer is connected to external power
and the battery is fully charged.

●

Blinking white: The battery has reached a low
battery level.

●

Amber: A battery is charging.

(6)

Power connector

Connects an AC adapter.

(7)

Security cable slot

Connects an optional security cable.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Bottom

Item

Component

Description

(1)

Battery bay

Holds the battery.

(2)

Battery release latch

Releases the battery from the battery bay.

(3)

Vents (4)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during
routine operation.

(4)

Hard drive bay

Holds the hard drive, the memory module slots, and
the WLAN module.
CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

Bottom
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Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Item

Description

Function

(1)

Serial number (s/n)

This is an alphanumeric identifier that is unique to
each product.

(2)

Part number/Product number (p/n)

This number provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(3)

Model description:

This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.

Chapter 3 Illustrated parts catalog

Computer major components

Computer major components
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Item

Component

(1)

17.3-in, high definition (HD), light-emitting diode (LED), BrightView display assembly (includes
webcam, two microphones, and wireless antenna transceivers and cables)
In butter gold finish

640223-001

In charcoal gray finish

640226-001

In luminous rose finish

640225-001

In ocean drive finish

640224-001

In Pacific blue finish

640221-001

In pearl pink finish

640228-001

In pewter finish

640227-001

In Sonoma red finish

640220-001

In sweet purple finish

640222-001

NOTE:
(2)

Spare part number

For more display assembly spare part information, see Display assembly subcomponents on page 28.

Keyboard (includes keyboard cable):
Keyboard in black finish

20

For use in Belgium

640208-A41

For use in Bulgaria (for use only with computer models equipped with an
AMD processor)

640208-261

For use in Canada

640208-121

For use in the Czech Republic

640208-221

For use in Denmark, Finland, and Norway

640208-DH1

For use in France

640208-051

For use in Germany

640208-041

For use in Greece

640208-DJ1

For use in Hungary

640208-211

For use in Israel

640208-BB1

For use in Italy

640208-061

For use in the Netherlands

640208-B31

For use in Portugal

640208-131

For use in Russia

640208-251

For use in Saudi Arabia

640208-171

For use in Slovenia

640208-BA1

For use in Spain

640208-071

For use in Switzerland

640208-BG1

Chapter 3 Illustrated parts catalog

Item

Component

Spare part number

For use in Turkey

640208-141

For use in the United Kingdom

640208-031

For use in the United States

640208-001

Keyboard in silver finish

(3)

For use in Belgium

647630-A41

For use in Bulgaria (for use only with computer models equipped with an
AMD processor)

647630-261

For use in Canada

647630-121

For use in the Czech Republic

647630-221

For use in Denmark, Finland, and Norway

647630-DH1

For use in France

647630-051

For use in Germany

647630-041

For use in Greece

647630-DJ1

For use in Hungary

647630-211

For use in Israel

647630-BB1

For use in Italy

647630-061

For use in the Netherlands

647630-B31

For use in Portugal

647630-131

For use in Russia

647630-251

For use in Saudi Arabia

647630-171

For use in Slovakia (for use only with computer models equipped with an
Intel processor)

647630-FL1

For use in Slovenia

647630-BA1

For use in Spain

647630-071

For use in Switzerland

647630-BG1

For use in Turkey

647630-141

For use in the United Kingdom

647630-031

For use in the United States

647630-001

Top cover (includes TouchPad and TouchPad cable):
In butter gold finish

641401-001

In charcoal gray finish

641404-001

In luminous rose finish

641403-001

In ocean drive finish

641402-001

Computer major components
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Item

Component

Spare part number

In Pacific blue finish

641399-001

In pearl pink finish

641406-001

In pewter finish

641405-001

In Sonoma red finish

640193-001

In sweet purple finish

641400-001

(4)

Power button board (includes cable)

640212-001

(5)

TouchPad LED board (includes cable)

640213-001

(6)

TouchPad button board (includes cable)

640214-001

Cable Kit, includes:

640206-001

(7a)

TouchPad cable

(7b)

Optical drive cable

(7c)

Hard drive connector cable
NOTE:

See Cable Kit on page 27 for more Cable Kit spare part information.

(8)

Speaker Kit (includes left and right speakers and cable)

641396-001

(9)

Bluetooth module (for use only with computer models equipped with an
Intel processor)

537921-001

NOTE: The Bluetooth module spare part kit does not include the Bluetooth
module cable. The Bluetooth module cable is available using spare part number
602538-001.
(10)

Bluetooth module cable (for use only with computer models equipped with an
Intel processor)

602538-001

(11)

USB board (includes cable)

640211-001

(12)

Power connector cable

641394-001

(13)

System board (includes replacement thermal material):
For use only with computer models equipped with an AMD processor:
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Equipped with an AMD Fusion E-450 1.65-GHz processor (dual core, 18 W) and a
graphics subsystem with UMA video memory

660773-001

For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with 1024-MB of discrete video memory

649950-001

For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with 512-MB of discrete video memory

649949-001

For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with UMA video memory

649948-001

For use only with computer models equipped with the AMD RS880MD chipset and a
graphics subsystem with 1024-MB of discrete video memory

647627-001

For use only with computer models equipped with the AMD RS880MD chipset and a
graphics subsystem with 512-MB of discrete video memory

647626-001
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Item

Component

Spare part number

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with 1024-MB of discrete video memory

638855-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with 512-MB of discrete video memory

638854-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with UMA video memory

638856-001

For use only with computer models equipped with an Intel processor:

(14)

For use only with computer models equipped with the Intel HM65 chipset and a
graphics subsystem with 1024-MB of discrete video memory and supports bus alive/
chip off (BACO)

650199-001

For use only with computer models equipped with the Intel HM65 chipset and a
graphics subsystem with 512-MB of discrete video memory and supports bus alive/
chip off (BACO)

650198-001

For use only with computer models equipped with the HM65 chipset and a graphics
subsystem with 1024-MB of discrete video memory

636375-001

For use only with computer models equipped with the HM65 chipset and a graphics
subsystem with 512-MB of discrete video memory

636374-001

For use only with computer models equipped with the HM65 chipset and a graphics
subsystem with UMA video memory

636373-001

For use only with computer models equipped with the HM55 chipset and a graphics
subsystem with 1024-MB of discrete video memory

636372-001

For use only with computer models equipped with the HM55 chipset and a graphics
subsystem with 512-MB of discrete video memory

636371-001

For use only with computer models equipped with the HM55 chipset and a graphics
subsystem with UMA video memory

636370-001

Equipped with an Intel Core i3-370M 2.40-GHz processor (3.0-MB L3 cache,
dual core, 35 W), the HM55 chipset, and a graphics subsystem with 1024-MB of
discrete video memory

654117-001

Equipped with an Intel Core i3-370M 2.40-GHz processor (3.0-MB L3 cache,
dual core, 35 W), the HM55 chipset, and a graphics subsystem with UMA video
memory

654118-001

Thermal Material Kit (includes replacement thermal paste and pads)

634433-001

Processor (includes replacement thermal material)
AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

653350-001

AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache,
quad core, 35 W)

653349-001

AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache,
dual core, 35 W)

653348-001

AMD Athlon II P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec,
dual core, 25 W)

636635-001
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Item

24

Component

Spare part number

AMD Athlon II P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec,
dual core, 25 W)

616343-001

AMD Phenom II N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/
sec, quad core, 35 W)

635496-001

AMD Phenom II N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/
sec, triple core, 35 W)

635495-001

AMD Phenom II N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/
sec, triple core, 35 W)

616345-001

AMD Phenom II N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/
sec, dual core, 35 W)

635494-001

AMD Phenom II P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
quad core, 25 W)

634689-001

AMD Phenom II P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 25 W)

634688-001

AMD Phenom II P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
triple core, 25 W)

634687-001

AMD Turion II P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
dual core, 25 W)

634691-001

AMD V160 2.40-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec,
single core, 25 W)

616333-001

AMD V140 2.30-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec,
single core, 25 W)

636634-001

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4.0-MB
L3 cache, dual core, 35 W)

631252-001

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB
L3 cache, dual core, 35 W)

631255-001

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB
L3 cache, dual core, 35 W)

631253-001

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3
cache, dual core, 35 W)

653341-001

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3.0-MB
L3 cache, dual core, 35 W)

638039-001

Intel Core i5-480M 2.66-GHz (SC turbo up to 2.93-GHz) processor (3.0-MB L3 cache,
dual core, 35 W)

634693-001

Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W)

653340-001

Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W)

653339-001

Intel Core i3-2310M 2.10-GHz processor (3.0-MB L3 cache, dual core, 35 W)

638037-001

Intel Core i3-390M 2.66-GHz processor (3.0-MB L3 cache, dual core, 35 W)

634692-001

Intel Core i3-380M 2.53-GHz processor (3.0-MB L3 cache, dual core, 35 W)

625823-001

Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core 35 W)

653338-001
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Spare part number

Intel Pentium B940 TJ85 2.00-GHz processor (2.0-MB L3 cache, dual core 35 W)

653337-001

Intel Pentium P6200 2.13-GHz processor (3.0-MB L3 cache, dual core, 35 W)

625831-001

Intel Pentium P6300 2.26-GHz processor (3.0-MB L3 cache, dual core, 35 W)

635500-001

(15)

Fan (includes replacement thermal material)

639460-001

(16)

Heat sink (includes replacement thermal material)
For use only with computer models equipped with an AMD processor:
For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with discrete video memory

649953-001

For use only with computer models equipped with the AMD A60M chipset and a
graphics subsystem with UMA video memory

649954-001

For use only with computer models equipped with the AMD RS880MD chipset and a
graphics subsystem with discrete video memory

649952-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with discrete video memory

639462-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with UMA video memory

639463-001

For use only with computer models equipped with an Intel processor:
For use only with computer models equipped with the Intel HM65 or HM55 chipset
and a graphics subsystem with discrete video memory and supports bus alive/chip off
(BACO)

654119-001

For use only with computer models equipped with the Intel HM65 or HM55 chipset
and a graphics subsystem with UMA video memory and supports bus alive/chip off
(BACO)

654120-001

For use only with computer models equipped with the HM65 chipset and a graphics
subsystem with discrete video memory

641141-001

For use only with computer models equipped with the HM65 chipset and a graphics
subsystem with UMA video memory

641140-001

For use only with computer models equipped with the HM55 chipset and a graphics
subsystem with discrete video memory

637190-001

For use only with computer models equipped with the HM55 chipset and a graphics
subsystem with UMA video memory

637189-001

(17)

LED board (includes cable)

640215-001

(18)

Base enclosure (includes battery release latch, heat sink, replacement
thermal material, and 4 rubber feet)

640203-001

Rubber Feet Kit (not illustrated, includes 4 rubber feet)

639455-001

(19)

Battery:
6-cell, 55-Whr, 2.55-Ah Li-ion battery

593554-001

6-cell, 47-Whr, 2.20-Ah Li-ion battery

593553-001

Computer major components
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Item

Component

Spare part number

(20)

RTC battery (includes cable and double-sided tape)

637193-001

(21)

Hard drive (2.5-in, 7.0-mm, SATA, does not include hard drive connector cable, isolators, or shield):
For use with all computer models:

(22)

(23)

(24)

750-GB, 5400-rpm

644351-001

640-GB, 5400-rpm

637312-001

500-GB, 7200-rpm

644685-001

320-GB, 7200-rpm

645089-001

320-GB, 5400-rpm

645086-001

250-GB, 7200-rpm

645091-001

Hard Drive Hardware Kit (not illustrated, includes front and rear isolators
and shield)

639444-001

Memory modules (2, DDR3, 10600, 1333-MHz):
4 GB

621569-001

2 GB

621565-001

1 GB

639736-001

Optical drive (includes bezel and bracket):
Blu-ray ROM with LightScribe DVD±R/RW Super Multi Double-Layer Drive

640210-001 and
659878-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

640209-001 and
659877-001

Optical drive bay space saver (not illustrated)

659617-001

WLAN module:
For use on all computer models:
Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo
adapter (BT3.0+HS ready)

600370-001

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter

630703-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

630705-001

For use only with computer models equipped with an AMD processor:
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Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter

605560-005

Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo
Adapter (BT3.0+HS ready)

593127-001

Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter

593836-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo
Adapter

657325-001
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Component

Spare part number

Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter

640926-001

Realtek 8188BC8 802.11a/b/g/n 2×2 WiFi and Bluetooth 3.0+HS Combo Adapter

602993-001

For use only with computer models equipped with an Intel processor:

(25)

Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter

518436-001

Intel Centrino Advanced-N 6230

631956-001

Intel Centrino Wireless-N 1000

593530-001

Service cover (includes 2 captive screws, secured by C-clips) — available in the Plastics Kit, spare part number
640216-001)

Cable Kit

Item

Component

Spare part number

Cable Kit, includes:

640206-001

(1)

TouchPad cable

(2)

Hard drive connector cable

(3)

Optical drive cable

Cable Kit

27

Display assembly subcomponents
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Item

Component

Spare part number

(1)

Display bezel

640204-001

(2)

Display hinge covers (2)

643698-001

(3)

Webcam/microphone module

637197-001

(4)

17.3-in, HD, LED, BrightView display panel

641395-001

(5)

Display Hinge Kit (includes left and right display hinges and brackets)

640207-001

(6)

Display Cable Kit (includes display panel cable and webcam/microphone
module cable)

640205-001

(7)

Antenna Kit (includes left and right wireless antenna cables and transceivers)

640192-001
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Item

Component

(8)

Display enclosure:

Spare part number

In butter gold finish

640197-001

In charcoal gray finish

640200-001

In luminous rose finish

640199-001

In ocean drive finish

640198-001

In Pacific blue finish

640195-001

In pearl pink finish

640202-001

In pewter finish

640201-001

In Sonoma red finish

640194-001

In sweet purple finish

640196-001

Display Screw Kit (not illustrated)

640218-001

Display assembly subcomponents
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Mass storage devices

Item

Component

Spare part number

(1)

Hard drive (2.5-in, 7.0-mm, SATA, does not include hard drive connector cable, isolators, or shield):
For use with all computer models:
750-GB, 5400-rpm

644351-001

640-GB, 5400-rpm

637312-001

500-GB, 7200-rpm

644685-001

320-GB, 7200-rpm

645089-001

320-GB, 5400-rpm

645086-001

250-GB, 7200-rpm

645091-001

Hard Drive Hardware Kit, includes:

639444-001

(2a)

Hard drive front isolator

(2b)

Hard drive rear isolator

(2c)

Hard drive shield

(3)

Optical drive (includes bezel and bracket):
Blu-ray ROM with LightScribe DVD±R/RW Super Multi Double-Layer Drive
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640210-001 and
659878-001

Item

Component

Spare part number

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

640209-001 and
659877-001

Optical drive bay space saver (not illustrated)

659617-001

Miscellaneous parts
Component

Spare part number

HP Smart AC adapter
90-W PFC RC V HP Smart AC adapter

609940-001

65-W RC V HP Smart AC adapter

609939-001

Power cord (3-pin, black, 1.83-m):
For use in Denmark

490371-081

For use in Europe

490371-021

For use in Israel

490371-BB1

For use in Italy

490371-061

For use in North America

490371-001

For use in South Africa

490371-AR1

For use in Switzerland

490371-111

For use in the United Kingdom and Singapore

490371-031

Screw Kit

640217-001

Miscellaneous parts
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Sequential part number listing
Spare part number

Description

490371-001

Power cord for use with all computer models in North America (3-pin, black, 1.83-m)

490371-021

Power cord for use only with computer models equipped with an Intel processor in Europe (3-pin,
black, 1.83-m)

490371-031

Power cord for use only with computer models equipped with an Intel processor in the United
Kingdom and Singapore (3-pin, black, 1.83-m)

490371-061

Power cord for use with all computer models in Italy (3-pin, black, 1.83-m)

490371-081

Power cord for use with all computer models in Denmark (3-pin, black, 1.83-m)

490371-111

Power cord for use only with computer models equipped with an Intel processor in Switzerland (3pin, black, 1.83-m)

490371-AR1

Power cord for use only with computer models equipped with an Intel processor in South Africa
(3-pin, black, 1.83-m)

490371-BB1

Power cord for use only with computer models equipped with an Intel processor in Israel (3-pin,
black, 1.83-m)

518436-001

Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter for use only with computer models equipped
with an Intel processor

537921-001

Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is available using spare part number 602538-001.
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593127-001

Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready) for use only with computer models equipped with an AMD processor

593530-001

Intel Centrino Wireless-N 1000 WLAN module for use only on computer models equipped with
an Intel processor

593553-001

6-cell, 47-Whr, 2.20-Ah Li-ion battery

593554-001

6-cell, 55-Whr, 2.55-Ah Li-ion battery

593836-001

Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter for use only on computer models equipped
with an AMD processor

600370-001

Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

602538-001

Bluetooth module cable

602993-001

Realtek 8188BC8 802.11a/b/g/n 2×2 WiFi and Bluetooth 3.0+HS Combo Adapter for use
only with computer models equipped with an AMD processor

605560-005

Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter

609939-001

65-W RC V HP Smart AC adapter for use only with computer models equipped with an
AMD processor

609940-001

90-W PFC RC V HP Smart AC adapter for use with all computer models
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Spare part number

Description

616333-001

AMD V140 2.30-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec, single core, 25 W;
includes replacement thermal material)

616343-001

AMD Athlon II P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core,
25 W; includes replacement thermal material)

616345-001

AMD Phenom II N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W; includes replacement thermal material)

621565-001

2-GB memory module (DDR3, 10600, 1333-MHz)

621569-001

4-GB memory module (DDR3, 10600, 1333-MHz)

625823-001

Intel i3-380M 2.53-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes replacement
thermal material)

625831-001

Intel Pentium P6200 2.13-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

630703-001

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter for use only on computer models equipped
with an Intel processor

630705-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(Bluetooth 3.0+HS ready)

631252-001

Intel i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4-MB L3 cache, dual core,
35 W; includes replacement thermal material)

631253-001

Intel i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB L3 cache, dual core,
35 W; includes replacement thermal material)

631255-001

Intel i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB L3 cache, dual core,
35 W; includes replacement thermal material)

631956-001

Intel Centrino Advanced-N 6230 WLAN module for use only on computer models equipped with
an Intel processor

634433-001

Thermal Material Kit (includes replacement thermal paste and pads)

634687-001

AMD Phenom II P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
triple core, 25 W; includes replacement thermal material)

634688-001

AMD Phenom II P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 25 W; includes replacement thermal material)

634689-001

AMD Phenom II P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec,
quad core, 25 W; includes replacement thermal material)

634691-001

AMD Turion II P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, dual core,
25 W; includes replacement thermal material)

634692-001

Intel i3-390M 2.66-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes replacement
thermal material)

634693-001

Intel i5-480M 2.66-GHz (SC turbo up to 2.93-GHz) processor (3.0-MB L3 cache, dual core,
35 W; includes replacement thermal material)

635494-001

AMD Phenom II N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/sec,
dual core, 35 W; includes replacement thermal material)

635495-001

AMD Phenom II N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec,
triple core, 35 W; includes replacement thermal material)
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34

Spare part number

Description

635496-001

AMD Phenom II N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/sec,
quad core, 35 W; includes replacement thermal material)

635500-001

Intel Pentium P6300 2.26-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes
replacement thermal material)

636370-001

System board for use only with computer models equipped with an Intel processor, HM55 chipset,
and a graphics subsystem with UMA video memory (includes replacement thermal material)

636371-001

System board for use only with computer models equipped with an Intel processor, HM55 chipset,
and a graphics subsystem with 512-MB of discrete video memory (includes replacement
thermal material)

636372-001

System board for use only with computer models equipped with an Intel processor, HM55 chipset,
and a graphics subsystem with 1024-MB of discrete video memory (includes replacement
thermal material)

636373-001

System board for use only with computer models equipped with an Intel processor, HM65 chipset,
and a graphics subsystem with UMA video memory (includes replacement thermal material)

636374-001

System board for use only with computer models equipped with an Intel processor, HM65 chipset,
and a graphics subsystem with 512-MB of discrete video memory (includes replacement
thermal material)

636375-001

System board for use only with computer models equipped with an Intel processor, HM65 chipset,
and a graphics subsystem with 512-MB of discrete video memory (includes replacement
thermal material)

636634-001

AMD V160 2.40-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec, single core, 25 W;
includes replacement thermal material)

636635-001

AMD Athlon II P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core,
25 W; includes replacement thermal material)

637189-001

System board for use only with computer models equipped with an Intel processor, HM55 chipset,
and a graphics subsystem with UMA video memory (includes replacement thermal material)

637190-001

System board for use only with computer models equipped with an Intel processor, HM55 chipset,
and a graphics subsystem with discrete video memory (includes replacement thermal material)

637193-001

RTC battery (includes cable and double-sided tape)

637197-001

Webcam/microphone module

637312-001

640-GB, 5400-rpm hard drive (2.5-in, SATA, does not include isolators or shield)

638037-001

Intel i3-2310M 2.10-GHz processor (3.0-MB L3 cache, dual core, 35 W; includes replacement
thermal material)

638039-001

Intel i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3.0-MB L3 cache, dual core,
35 W; includes replacement thermal material)

638854-001

System board for use only with computer models equipped with an AMD Athlon, Phenom, Turion,
or V-series processor and a graphics subsystem with 512-MB of discrete video memory (includes
replacement thermal material)

638855-001

System board for use only with computer models equipped with an AMD Athlon, Phenom, Turion,
or V-series processor and a graphics subsystem with 1024-MB of discrete video memory (includes
replacement thermal material)
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Spare part number

Description

638856-001

System board for use only with computer models equipped with an AMD Athlon, Phenom, Turion,
or V-series processor and a graphics subsystem with UMA video memory (includes replacement
thermal material)

639444-001

Hard Drive Hardware Kit (includes front and rear isolators and shield)

639455-001

Rubber Feet Kit (includes 4 rubber feet)

639460-001

Fan (includes replacement thermal material)

639462-001

Heat sink for use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with discrete video memory (includes replacement
thermal material)

639463-001

Heat sink for use only with computer models equipped with an AMD Athlon, Phenom, Turion, or
V-series processor and a graphics subsystem with UMA video memory (includes replacement
thermal material)

639736-001

1-GB memory module (DDR3, 10600, 1333-MHz)

640192-001

Antenna Kit (includes left and right wireless antenna cables and transceivers)

640193-001

Top cover in Sonoma red finish (includes TouchPad and TouchPad cable)

640194-001

Display enclosure in Sonoma red finish

640195-001

Display enclosure in Pacific blue finish

640196-001

Display enclosure in sweet purple finish

640197-001

Display enclosure in butter gold finish

640198-001

Display enclosure in ocean drive finish

640199-001

Display enclosure in luminous rose finish

640200-001

Display enclosure in charcoal gray finish

640201-001

Display enclosure in pewter finish

640202-001

Display enclosure in pearl pink finish

640203-001

Base enclosure (includes battery release latch, heat sink, replacement thermal material, and 4
rubber feet)

640204-001

Display bezel

640205-001

Display Cable Kit (includes display panel cable and webcam/microphone module cable)

640206-001

Cable Kit (includes hard drive connector cable, optical drive cable, and TouchPad cable)
NOTE:

See Cable Kit on page 27 for more Cable Kit spare part information.

640207-001

Display Hinge Kit (includes left and right display hinges and brackets)

640208-001

Keyboard in black finish for use in the United States (includes keyboard cable)

640208-031

Keyboard in black finish for use in the United Kingdom and Singapore (includes keyboard cable)

640208-041

Keyboard in black finish for use in Germany (includes keyboard cable)

640208-051

Keyboard in black finish for use in France (includes keyboard cable)
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Spare part number

Description

640208-061

Keyboard in black finish for use in Italy (includes keyboard cable)

640208-071

Keyboard in black finish for use in Spain (includes keyboard cable)

640208-121

Keyboard in black finish for use in Canada (includes keyboard cable)

640208-131

Keyboard in black finish for use in Portugal (includes keyboard cable)

640208-141

Keyboard in black finish for use in Turkey (includes keyboard cable)

640208-171

Keyboard in black finish for use in Saudi Arabia (includes keyboard cable)

640208-211

Keyboard in black finish for use in Hungary (includes keyboard cable)

640208-221

Keyboard in black finish for use in the Czech Republic (includes keyboard cable)

640208-251

Keyboard in black finish for use in Russia (includes keyboard cable)

640208-261

Keyboard in black finish for use in Bulgaria (for use only with computer models equipped with an
AMD processor; includes keyboard cable)

640208-A41

Keyboard in black finish for use in Belgium (includes keyboard cable)

640208-B31

Keyboard in black finish for use in the Netherlands (includes keyboard cable)

640208-BA1

Keyboard in black finish for use in Slovenia (includes keyboard cable)

640208-BB1

Keyboard in black finish for use in Israel (includes keyboard cable)

640208-BG1

Keyboard in black finish for use in Switzerland (includes keyboard cable)

640208-DH1

Keyboard in black finish for use in Denmark, Finland, and Norway (includes keyboard cable)

640208-DJ1

Keyboard in black finish for use in Greece (includes keyboard cable)

640209-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

640210-001

Blu-ray ROM with LightScribe DVD±R/RW Super Multi Double-Layer Drive

640211-001

USB board (includes cable)

640212-001

Power button board (includes cable)

640213-001

TouchPad LED board (includes cable)

640214-001

TouchPad button board (includes cable)

640215-001

LED board (includes cable)

640216-001

Plastics Kit (includes the service cover)

640217-001

Screw Kit

640218-001

Display Screw Kit

640220-001

17.3-in, HD, LED, BrightView display assembly in Sonoma red finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640221-001

17.3-in, HD, LED, BrightView display assembly in Pacific blue finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640222-001

17.3-in, HD, LED, BrightView display assembly in sweet purple finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)
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Spare part number

Description

640223-001

17.3-in, HD, LED, BrightView display assembly in butter gold finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640224-001

17.3-in, HD, LED, BrightView display assembly in ocean drive finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640225-001

17.3-in, HD, LED, BrightView display assembly in luminous rose finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640226-001

17.3-in, HD, LED, BrightView display assembly in charcoal gray finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640227-001

17.3-in, HD, LED, BrightView display assembly in pewter finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640228-001

17.3-in, HD, LED, BrightView display assembly in pearl pink finish (includes webcam, two
microphones, and wireless antenna transceivers and cables)

640926-001

Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter for use only with computer models
equipped with an AMD processor

641140-001

Heat sink for use only with computer models equipped with an Intel processor, the HM65 chipset,
and a graphics subsystem with UMA video memory (includes replacement thermal material)

641141-001

Heat sink for use only with computer models equipped with an Intel processor, the HM65 chipset,
and a graphics subsystem with discrete video memory (includes replacement thermal material)

641394-001

Power connector cable

641395-001

17.3-in, HD, LED, BrightView display panel

641396-001

Speaker Kit (includes left and right speakers and cable)

641399-001

Top cover in Pacific blue finish (includes TouchPad and TouchPad cable)

641400-001

Top cover in sweet purple finish (includes TouchPad and TouchPad cable)

641401-001

Top cover in butter gold finish (includes TouchPad and TouchPad cable)

641402-001

Top cover in ocean drive finish (includes TouchPad and TouchPad cable)

641403-001

Top cover in luminous rose finish (includes TouchPad and TouchPad cable)

641404-001

Top cover in charcoal gray finish (includes TouchPad and TouchPad cable)

641405-001

Top cover in pewter finish (includes TouchPad and TouchPad cable)

641406-001

Top cover in pearl pink finish (includes TouchPad and TouchPad cable)

643698-001

Display hinge covers

644351-001

750-GB, 5400-rpm hard drive (2.5-in, 7.0-mm, SATA, does not include hard drive connector
cable, isolators, or shield)

644685-001

500-GB, 7200-rpm hard drive (2.5-in, 7.0-mm, SATA, does not include hard drive connector
cable, isolators, or shield)

645086-001

320-GB, 5400-rpm hard drive (2.5-in, 7.0-mm, SATA, does not include hard drive connector
cable, isolators, or shield)

645089-001

320-GB, 7200-rpm hard drive (2.5-in, 7.0-mm, SATA, does not include hard drive connector
cable, isolators, or shield)
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Spare part number

Description

645091-001

250-GB, 7200-rpm hard drive (2.5-in, 7.0-mm, SATA, does not include hard drive connector
cable, isolators, or shield)

647626-001

System board for use only with computer models equipped with the AMD RS880MD chipset, an
AMD processor, and a graphics subsystem with 512-MB of discrete video memory (includes
replacement thermal material)

647627-001

System board for use only with computer models equipped with the AMD RS880MD chipset, an
AMD processor, and a graphics subsystem with 1024-MB of discrete video memory (includes
replacement thermal material)

647630-001

Keyboard in silver finish for use in the United States (includes keyboard cable)

647630-031

Keyboard in silver finish for use in the United Kingdom and Singapore (includes keyboard cable)

647630-041

Keyboard in silver finish for use in Germany (includes keyboard cable)

647630-051

Keyboard in silver finish for use in France (includes keyboard cable)

647630-061

Keyboard in silver finish for use in Italy (includes keyboard cable)

647630-071

Keyboard in silver finish for use in Spain (includes keyboard cable)

647630-121

Keyboard in silver finish for use in Canada (includes keyboard cable)

647630-131

Keyboard in silver finish for use in Portugal (includes keyboard cable)

647630-141

Keyboard in silver finish for use in Turkey (includes keyboard cable)

647630-171

Keyboard in silver finish for use in Saudi Arabia (includes keyboard cable)

647630-211

Keyboard in silver finish for use in Hungary (includes keyboard cable)

647630-221

Keyboard in silver finish for use in the Czech Republic (includes keyboard cable)

647630-251

Keyboard in silver finish for use in Russia (includes keyboard cable)

647630-261

Keyboard in silver finish for use in Bulgaria (for use only with computer models equipped with an
AMD processor; includes keyboard cable)

647630-A41

Keyboard in silver finish for use in Belgium (includes keyboard cable)

647630-B31

Keyboard in silver finish for use in the Netherlands (includes keyboard cable)

647630-BA1

Keyboard in silver finish for use in Slovenia (includes keyboard cable)

647630-BB1

Keyboard in silver finish for use in Israel (includes keyboard cable)

647630-BG1

Keyboard in silver finish for use in Switzerland (includes keyboard cable)

647630-DH1

Keyboard in silver finish for use in Denmark, Finland, and Norway (includes keyboard cable)

647630-DJ1

Keyboard in silver finish for use in Greece (includes keyboard cable)

647630-FL1

Keyboard in silver finish for use in the Slovakia (for use only with computer models equipped with
an Intel processor; includes keyboard cable)

649948-001

System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)
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Description

649949-001

System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with 512-MB of discrete video memory (includes
replacement thermal material)

649950-001

System board for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with 1024-MB of discrete video memory (includes
replacement thermal material)

649952-001

Heat sink for use only with computer models equipped with the AMD RS880MD chipset, an
AMD processor, and a graphics subsystem with discrete video memory (includes replacement
thermal material)

649953-001

Heat sink for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with discrete video memory (includes replacement
thermal material)

649954-001

Heat sink for use only with computer models equipped with the AMD A60M chipset, an
AMD processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)

650198-001

System board for use only with computer models equipped with the Intel HM65 chipset, an
Intel processor, and a graphics subsystem with 512-MB of discrete video memory and supports
bus alive/chip off (BACO; includes replacement thermal material)

650199-001

System board for use only with computer models equipped with the Intel HM65 chipset, an
Intel processor, and a graphics subsystem with 1024-MB of discrete video memory and supports
bus alive/chip off (BACO; includes replacement thermal material)

653337-001

Intel Pentium B940 TJ85 2.00-GHz processor (2.0-MB L3 cache, dual core 35 W; includes
replacement thermal material)

653338-001

Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core 35 W; includes
replacement thermal material)

653339-001

Intel core i3-2330M 2.20-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, dual core, 35 W;
includes replacement thermal material)

653340-001

Intel Core i3-2350M 2.30-GHz processor (1333-MHz FSB, 3.0-MB L3 cache, dual core, 35 W;
includes replacement thermal material)

653341-001

Intel Core i5-2430M 2.40-GHz processor (turbo up to 3.00-GHz; 1333-MHz, 3.0-MB L3 cache,
dual core, 35 W; includes replacement thermal material)

653348-001

AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 35 W;
includes replacement thermal material)

653349-001

AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)

653350-001

AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core, 35 W;
includes replacement thermal material)

654117-001

System board equipped with an Intel Core i3-370M 2.40-GHz processor (3.0-MB L3 cache,
dual core, 35 W), the HM55 chipset, and a graphics subsystem with 1024-MB of discrete video
memory (includes replacement thermal material)

654118-001

System board equipped with an Intel Core i3-370M 2.40-GHz processor (3.0-MB L3 cache,
dual core, 35 W), the HM55 chipset, and a graphics subsystem with UMA video memory
(includes replacement thermal material)
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654119-001

Heat sink for use only with computer models equipped with the Intel HM65 or HM55 chipset, an
Intel processor, and a graphics subsystem with discrete video memory (includes replacement
thermal material)

654120-001

Heat sink for use only with computer models equipped with the Intel HM65 or HM55 chipset, an
Intel processor, and a graphics subsystem with UMA video memory (includes replacement
thermal material)

657325-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

659617-001

Optical drive bay space saver

659877-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

659878-001

Blu-ray ROM with LightScribe DVD±R/RW Super Multi Double-Layer Drive

660773-001

System board for use only with computer models equipped with an AMD Fusion E-450 1.65-GHz
processor (dual core, 18 W) and a graphics subsystem with UMA video memory (includes
replacement thermal material)
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Removal and replacement
procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Magnetic screwdriver

●

Phillips P0 and P1 screwdrivers

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in
the maintenance instructions.

Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Preliminary replacement requirements
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Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether
the computer is off or in Hibernation, turn the computer on, and then shut it down through
the operating system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
the following table shows how humidity affects the electrostatic voltage levels generated by
different activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event

10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
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●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of staticsafe materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
Material

Use

Voltage protection level

Antistatic plastics

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 51 screws that must be removed, replaced, or loosened when servicing
the computer. Make special note of each screw size and location during removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag.
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Item

Description

Function

(1)

Serial number (s/n)

This is an alphanumeric identifier that is unique to
each product.

(2)

Part number/Product number (p/n)

This number provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(3)

Model description:

This is the alphanumeric identifier needed to locate
documents, drivers, and support for the computer.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Feet Kit, spare
part number 639455-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.

Battery
Description

Spare part number

6-cell, 55-Whr, 2.55-Ah Li-ion battery

593554-001

6-cell, 47-Whr, 2.20-Ah Li-ion battery

593553-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1.

Slide the battery release latch (1) to release the battery.

2.

Pivot the front edge of the battery (2) up and back.

Component replacement procedures

47

3.

Remove the battery (3) from the computer.

To insert the battery:
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1.

Align the tabs on the rear edge of the battery with the notches on the rear edge of the battery bay.

2.

Pivot the front edge of the battery down into the battery bay until it is seated. (The battery release
latch will automatically lock into place.)
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Optical drive
NOTE: The optical drive spare part kit includes a bezel and bracket.
Description

Spare part number

Blu-ray ROM with LightScribe DVD ±R/RW Super Multi Double-Layer Drive

640210-001 and
659878-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

640209-001 and
659877-001

Optical drive bay space saver

659617-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the optical drive:
1.

Loosen the two captive screws (1) that secure the service cover to the computer.

2.

Lift the rear edge of the service cover (2) up and forward until it rests at an angle.

3.

Remove the service cover. The service cover is available in the Plastics Kit, spare part number
640216-001.

4.

Remove the Phillips PM2.5×4.0 screw (1) that secures the optical drive to the computer.
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5.

Remove the optical drive (2) by sliding it out of the optical drive bay.

6.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear panel
toward you.

7.

Remove the two Phillips PM2.0×4.0 screws (1) that secure the bracket to the optical drive.

8.

Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Hard drive
NOTE: The hard drive spare part kit does not include the hard drive connector cable, isolators, or
shield. The hard drive connector cable, isolators, and shield are included in the Hard Drive Hardware
Kit, spare part number 639444-001. The hard drive connector cable is included in the Cable Kit, spare
part number 640206-001.
Description

Spare part number

For use with all computer models:
750-GB, 5400-rpm

644351-001

640-GB, 5400-rpm

637312-001

500-GB, 7200-rpm

644685-001

320-GB, 7200-rpm

645089-001

320-GB, 5400-rpm

645086-001

250-GB, 7200-rpm

645091-001

Before removing the hard drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the service cover (see Optical drive on page 49).

Remove the hard drive:
1.

Disconnect the hard drive connector cable (1) from the system board.
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2.

Lift the front edge of the hard drive (2) until it rests at an angle.

3.

Remove the hard drive.

4.

If it is necessary to replace the hard drive connector cable (1), the hard drive isolators (2), or
the shield (3) from the hard drive, remove and replace the components.

Reverse this procedure to reassemble and install the mass storage device.

52

Chapter 4 Removal and replacement procedures

RTC battery
Description

Spare part number

RTC battery (includes cable and double-sided tape)

637193-001

Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the service cover (see Optical drive on page 49).

Remove the RTC battery:
1.

Disconnect the RTC battery cable (1) from the system board.

2.

Slide the RTC battery (2) out from under the surface of the base enclosure.

3.

Remove the RTC battery (3) from the system board. (The RTC battery is attached to the system
board with double-sided tape.)

Reverse this procedure to install the RTC battery.
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Memory module
Description

Spare part number

4-GB (DDR3, 10600, 1333-MHz)

621569-001

2-GB (DDR3, 10600, 1333-MHz)

621565-001

1-GB (DDR3, 10600, 1333-MHz)

639736-001

Before removing a memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the service cover (see Optical drive on page 49).

Remove the memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The memory module tilts up.)

2.

Remove the memory module (2) by pulling it away from the slot at an angle.

Reverse this procedure to install a memory module.

54

Chapter 4 Removal and replacement procedures

WLAN module
Description

Spare part number

For use on all computer models:
Broadcom 4313 802.11b/g/n 1×1 WiFi and 2070 Bluetooth 2.1+EDR Combo adapter
(BT3.0+HS ready)

600370-001

Ralink 5390GN 802.11b/g/n 1×1 WiFi Adapter

630703-001

Ralink RT3090BC4 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

630705-001

For use only with computer models equipped with an AMD processor:
Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter

605560-005

Atheros AR8002WB-1NGB 802.11b/g/n 1×1 WiFi and Bluetooth 2.1+EDR Combo Adapter
(BT3.0+HS ready)

593127-001

Broadcom 4313 802.11b/g/n 1×1 WiFi Adapter

593836-001

Broadcom 4313GN 802.11b/g/n 1×1 WiFi and 20702 Bluetooth 4.0 Combo Adapter

657325-001

Realtek RTL8191SE 802.11b/g/n 1×1 WiFi Adapter

640926-001

Realtek 8188BC8 802.11a/b/g/n 2×2 WiFi and Bluetooth 3.0+HS Combo Adapter

602993-001

For use only with computer models equipped with an Intel processor:
Atheros 9285G 802.11b/g/n 1×1 WiFi Adapter

518436-001

Intel Centrino Advanced-N 6230

631956-001

Intel Centrino Wireless-N 1000

593530-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove
the module to restore device functionality, and then contact technical support.
Before removing the WLAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the service cover (see Optical drive on page 49).
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Remove the WLAN module:
1.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The 1/black WLAN antenna cable is connected to the WLAN module 1/Main terminal.
The 2/gray WLAN antenna cable is connected to the WLAN module 2/Aux terminal.

2.

Remove the Phillips PM2.5×6.0 screw (2) that secures the WLAN module to the system board.
(The WLAN module tilts up (3).)

3.

Remove the WLAN module by pulling the module away from the slot at an angle (4).
NOTE: The WLAN module is designed with a notch (5) to prevent incorrect installation into
the WLAN module socket.

NOTE: If the WLAN antennas are not connected to the terminals on the WLAN module, the protective
sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.
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Keyboard
NOTE: The keyboard spare part kit includes a keyboard cable.
Description

Spare part number

Description

Spare part number

For use in Belgium

640208-A41

For use in the Netherlands

640208-B31

For use in Bulgaria (for use only with
computer models equipped with an
AMD processor)

640208-261

For use in Portugal

640208-131

For use in Canada

640208-121

For use in Russia

640208-251

For use in the Czech Republic

640208-221

For use in Saudi Arabia

640208-171

For use in Denmark, Finland,
and Norway

640208-DH1

For use in Slovenia

640208-BA1

For use in France

640208-051

For use in Spain

640208-071

For use in Germany

640208-041

For use in Switzerland

640208-BG1

For use in Greece

640208-DJ1

For use in Turkey

640208-141

For use in Hungary

640208-211

For use in the United Kingdom

640208-031

For use in Israel

640208-BB1

For use in the United States

640208-001

For use in Italy

640208-061

Keyboard in black finish:

Keyboard in silver finish:
For use in Belgium

647630-A41

For use in the Netherlands

647630-B31

For use in Bulgaria (for use only with
computer models equipped with an
AMD processor)

647630-261

For use in Portugal

647630-131

For use in Canada

647630-121

For use in Russia

647630-251

For use in the Czech Republic

647630-221

For use in Saudi Arabia

647630-171

For use in Denmark, Finland,
and Norway

647630-DH1

For use in Slovakia (for use only with
computer models equipped with an
Intel processor)

647630-FL1

For use in France

647630-051

For use in Slovenia

647630-BA1

For use in Germany

647630-041

For use in Spain

647630-071

For use in Greece

647630-DJ1

For use in Switzerland

647630-BG1

For use in Hungary

647630-211

For use in Turkey

647630-141

For use in Israel

647630-BB1

For use in the United Kingdom

647630-031

For use in Italy

647630-061

For use in the United States

647630-001
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Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the service cover (see Optical drive on page 49).

Remove the keyboard:
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1.

Remove the Phillips PM2.5×7.0 screw that secures the keyboard to the computer.

2.

Rest the computer on its left side.

3.

Open the computer.
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4.

Insert a screw driver or similar thin tool into the keyboard screw hole, and then press on the back
of the keyboard until the keyboard disengages from the computer.

5.

Turn the computer right-side up with the front toward you.

6.

Lift the rear edge of the keyboard, and then swing the keyboard up and forward until it rests
upside down on the palm rest.
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7.

Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
then disconnect the keyboard cable (2) from the system board.

8.

Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover
NOTE: The top cover spare part kit includes the TouchPad and TouchPad cable.
Description

Spare part number

In butter gold finish

641401-001

In charcoal gray finish

641404-001

In luminous rose finish

641403-001

In ocean drive finish

641402-001

In Pacific blue finish

641399-001

In pearl pink finish

641406-001

In pewter finish

641405-001

In Sonoma red finish

640193-001

In sweet purple finish

641400-001

Before removing the top cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

When replacing the top cover, be sure that the following components are removed from the defective
top cover and installed on the replacement top cover:
●

Power button board and cable (see Power button board on page 64)

●

TouchPad button board and cable (see TouchPad button board on page 66)

●

TouchPad LED board and cable (see TouchPad LED board on page 67)

Remove the top cover:
1.

Close the computer.

2.

Turn the computer upside down, with the front toward you.
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3.

Remove the 12 Phillips PM2.5×7.0 screws that secure the top cover to the computer.

4.

Remove the two Phillips PM2.5×7.0 screws (1) in the hard drive bay and the three Phillips
PM2.5×6.0 screws (2) in the battery bay that secure the top cover to the computer.

5.

Turn the computer right-side up, with the front toward you.

6.

Open the computer.

7.

Release the ZIF connectors to which the following cables are attached, and then disconnect
the cables from the system board:
●

Power button board cable (1) (included with the power button board spare part kit, spare
part number 640212-001)

●

TouchPad cable (2) (included in the Cable Kit, spare part number 640206-001)

●

TouchPad button board cable (3) (included with the TouchPad button board spare part kit,
spare part number 640214-001)
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8.

Remove the Phillips PM2.5×6.0 screw (1) that secures the top cover to the computer.

9.

Lift the rear edge of the top cover (2) until the left and right sides disengage from
the base enclosure.

10. Remove the top cover (3).

Reverse this procedure to install the top cover.
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Power button board
Description

Spare part number

Power button board (includes cable)

640212-001

Before removing the power button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

Remove the power button board:
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1.

Turn the top cover upside down, with the front toward you.

2.

Release the power button board cable from the clip (1) built into the top cover.

3.

Remove the Phillips PM2.0×4.0 screw (2) that secures the power button board to the top cover.

4.

Lift the right side of the power button board (3) until it rests at an angle.
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5.

Remove the power button board and cable by sliding the board up and to the right at an
angle (4).

Reverse this procedure to install the power button board and cable.
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TouchPad button board
Description

Spare part number

TouchPad button board (includes cable)

640214-001

Before removing the TouchPad button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

Remove the TouchPad button board and cable:
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1.

Turn the top cover upside down, with the front toward you.

2.

Release the TouchPad board cable (1) and the TouchPad button board cable (2) from
the clips (3) built into the top cover.

3.

Release the ZIF connector to which the TouchPad LED board cable is connected, and then
disconnect the TouchPad LED board cable (4) from the TouchPad button board.

4.

Remove the Phillips PM2.0×4.0 screw (5) that secures the TouchPad button board to
the top cover.
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5.

Lift the rear edge of the TouchPad button board (6) until it is released from the clips built into
the top cover.

6.

Remove the TouchPad button board and cable.

Reverse this procedure to install the TouchPad button board and cable.

TouchPad LED board
Description

Spare part number

TouchPad LED board (includes cable)

640213-001

Before removing the TouchPad LED board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)
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Remove the TouchPad LED board and cable:
1.

Turn the top cover upside down, with the front toward you.

2.

Release the ZIF connector (1) to which the TouchPad LED board cable is connected, and then
disconnect the TouchPad LED board cable (2) from the TouchPad button board.

3.

Release the TouchPad LED board cable from the clip (3) built into the top cover.

4.

Detach the TouchPad LED board (4) from the top cover. (The TouchPad LED board is attached to
the top cover with double-sided tape.)

5.

Remove the TouchPad LED board and cable.

Reverse this procedure to install the TouchPad LED board and cable.

68

Chapter 4 Removal and replacement procedures

Bluetooth module
NOTE: This section applies only to computer models equipped with an Intel processor.
Description

Spare part number

Bluetooth module

537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is available using spare part number 602538-001.

Before removing the Bluetooth module and cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

Remove the Bluetooth module and cable:
1.

Disconnect the Bluetooth module cable (1) from the system board.
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2.

Release the clips (2) built into the base enclosure that secure the Bluetooth module, and then
remove the module (3) from the clips.

3.

If it is necessary to replace the Bluetooth module cable, disconnect the cable from the Bluetooth
module and replace it.
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Reverse this procedure to install the Bluetooth module and cable.

Speakers
Description

Spare part number

Speaker Kit (includes left and right speakers and cable)

641396-001

Before removing the speakers, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

Remove the TouchPad LED board and cable:
1.

Disconnect the speaker cable (1) from the system board.

2.

Remove the speakers (2).
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Reverse this procedure to install the speakers.

LED board
Description

Spare part number

LED board

640215-001

Before removing the LED board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

Remove the LED board:
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1.

Release the ZIF connector (1) to which the LED board cable is connected, and then disconnect
the LED board cable (2) from the system board.

2.

Release the clips (3) built into the base enclosure that secure the LED board.

3.

Lift the right edge of the LED board (4) to release it from clips built into the base enclosure.
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4.

Remove the LED board and cable by sliding the board (5) up and to the right at an angle.

Reverse this procedure to install the LED board and cable.
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USB board
Description

Spare part number

USB board (includes cable)

640211-001

Before removing the USB board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

Remove the USB board:
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1.

Release the ZIF connector (1) to which the USB board cable is connected, and then disconnect
the USB board cable (2) from the system board.

2.

Release the clip (3) built into the base enclosure that secures the USB board to the base enclosure.
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3.

Remove the USB board (4) and cable.

Reverse this procedure to install the USB board.

Power connector cable
Description

Spare part number

Power connector cable

641394-001

Before removing the power connector cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

●

USB board (see USB board on page 74)
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Remove the power connector cable:
1.

Disconnect the power connector cable (1) from the system board.

2.

Release the power connector cable (2) from the clips (3) built into the base enclosure.

3.

Remove the power connector (4) from the clip (5) built into the base enclosure.

Reverse this procedure to install the power connector cable.
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System board
NOTE: The system board spare part kit includes replacement thermal material. Replacement
thermal material is also available in the Thermal Material Kit, spare part number 634433-001.
Description

Spare part number

For use only with computer models equipped with an AMD processor:
Equipped with an AMD Fusion E-450 1.65-GHz processor (dual core, 18 W) and a graphics
subsystem with UMA video memory

660773-001

For use only with computer models equipped with the AMD A60M chipset and a graphics subsystem
with 1024-MB of discrete video memory

649950-001

For use only with computer models equipped with the AMD A60M chipset and a graphics subsystem
with 512-MB of discrete video memory

649949-001

For use only with computer models equipped with the AMD A60M chipset and a graphics subsystem
with UMA video memory

649948-001

For use only with computer models equipped with the AMD RS880MD chipset and a graphics
subsystem with 1024-MB of discrete video memory

647627-001

For use only with computer models equipped with the AMD RS880MD chipset and a graphics
subsystem with 512-MB of discrete video memory

647626-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or V-series
processor and a graphics subsystem with 1024-MB of discrete video memory

638855-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or V-series
processor and a graphics subsystem with 512-MB of discrete video memory

638854-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or V-series
processor and a graphics subsystem with UMA video memory

638856-001

For use only with computer models equipped with an Intel processor:
For use only with computer models equipped with the Intel HM65 chipset and a graphics subsystem
with 1024-MB of discrete video memory and supports bus alive/chip off (BACO)

650199-001

For use only with computer models equipped with the Intel HM65 chipset and a graphics subsystem
with 512-MB of discrete video memory and supports bus alive/chip off (BACO)

650198-001

For use only with computer models equipped with the HM65 chipset and a graphics subsystem with
1024-MB of discrete video memory

636375-001

For use only with computer models equipped with the HM65 chipset and a graphics subsystem with
512-MB of discrete video memory

636374-001

For use only with computer models equipped with an HM65 chipset and a graphics subsystem with
UMA video memory

636373-001

For use only with computer models equipped with the HM55 chipset and a graphics subsystem with
1024-MB of discrete video memory

636372-001

For use only with computer models equipped with the HM55 chipset and a graphics subsystem with
512-MB of discrete video memory

636371-001

For use only with computer models equipped with the HM55 chipset and a graphics subsystem with
UMA video memory

636370-001
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Description

Spare part number

Equipped with an Intel Core i3-370M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W), the
HM55 chipset, and a graphics subsystem with 1024-MB of discrete video memory

654117-001

Equipped with an Intel Core i3-370M 2.40-GHz processor (3.0-MB L3 cache, dual core, 35 W), the
HM55 chipset, and a graphics subsystem with UMA video memory

654118-001

Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

RTC battery (see RTC battery on page 53)

●

WLAN module (see WLAN module on page 55)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:
●

Memory module (see Memory module on page 54)

●

Fan and heat sink (see Fan and heat sink on page 83)

●

Processor (see Processor on page 90)

Remove the system board:
1.
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Disconnect the following cables from the system board:
●

LED board cable (1)

●

Speaker cable (2)

●

Optical drive cable (3)

●

Display panel cable (4)
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2.

Remove the Philllips PM2.5×7.0 screw (5) that secures the system board to the base enclosure.

3.

Disconnect the power connector cable (1) from the system board.

4.

Release the ZIF connector to which the USB board cable is attached, and then disconnect the USB
cable (2) from the system board.

5.

Lift the right side of the system board (1) until it rests at an angle.
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6.

Remove the system board (2) by sliding it up and to the right at an angle.

NOTE: System boards for use with computer models equipped with an AMD processor have
the Southbridge chip located on the bottom of the board. A thermal pad is used on
the Southbridge chip (1) and the base enclosure heat sink (2) that services it. The thermal material
must be thoroughly cleaned from the surfaces of the system board and the heat sink attached to
the base enclosure each time the system board is removed. Replacement thermal material is
included with all base enclosure and system board spare part kits.
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Reverse this procedure to install the system board.

Optical drive cable
NOTE: The optical drive cable is included in the Cable Kit, spare part number 640206-001.
The optical drive cable includes the optical drive connector.
Before removing the optical drive cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

●

System board (see System board on page 77)

Remove the optical drive cable:
1.

Release the optical drive cable (1) from the clips (2) built into the base enclosure.
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2.

Release the clips (3) built into the base enclosure that secure the optical drive connector, and then
release the connector (4) from the clips.

3.

Remove the optical drive connector and cable.

Reverse this procedure to install the optical drive connector and cable.
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Fan and heat sink
NOTE: The fan and heat sink spare part kits include replacement thermal material. Replacement
thermal material is also available in the Thermal Material Kit, spare part number 634433-001.
Description

Spare part number

Fan

639460-001

Heat sink:
For use only with computer models equipped with an AMD processor:
For use only with computer models equipped with the AMD A60M chipset and a graphics subsystem
with discrete video memory

649953-001

For use only with computer models equipped with the AMD A60M chipset and a graphics subsystem
with UMA video memory

649954-001

For use only with computer models equipped with the AMD RS880MD chipset and a graphics
subsystem with discrete video memory

649952-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or V-series
processor and a graphics subsystem with discrete video memory

639462-001

For use only with computer models equipped with an AMD Athlon, Phenom, Turion, or V-series
processor and a graphics subsystem with UMA video memory

639463-001

For use only with computer models equipped with an Intel processor:
For use only with computer models equipped with the Intel HM65 or HM55 chipset and a graphics
subsystem with discrete video memory and supports bus alive/chip off (BACO)

654119-001

For use only with computer models equipped with the Intel HM65 or HM55 chipset and a graphics
subsystem with UMA video memory and supports bus alive/chip off (BACO)

654120-001

For use only with computer models equipped with the HM65 chipset and a graphics subsystem with
discrete video memory

641141-001

For use only with computer models equipped with the HM65 chipset and a graphics subsystem with
UMA video memory

641140-001

For use only with computer models equipped with the HM55 chipset and a graphics subsystem with
discrete video memory

637190-001

For use only with computer models equipped with the HM55 chipset and a graphics subsystem with
UMA video memory

637189-001

NOTE: To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of
the computer. The computer uses an electric fan for ventilation. The fan is controlled by a temperature
sensor and is designed to turn on automatically when high temperature conditions exist. These
conditions are affected by high external temperatures, system power consumption, power
management/battery conservation configurations, battery fast charging, and software requirements.
Exhaust air is displaced through the ventilation grill located on the left side of the computer.

Component replacement procedures

83

Before removing the fan and heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 55)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

●

System board (see System board on page 77)

Remove the fan and heat sink:
1.

Turn the system board upside down, with the fan toward you.
NOTE: Steps 2 through 5 apply only to computer models equipped with a graphics subsystem
with discrete memory. See steps 6 through 8 for fan and heat sink removal information for
computer models equipped with a graphics subsystem with UMA memory.

2.

Disconnect the fan cable (1) from the system board.

3.

Loosen the captive screws (2) that secure the fan and heat sink to the system board. (Computer
models equipped with an AMD processor have three captive screws. Computer models equipped
with an Intel processor have four captive screws.)

4.

Remove the three Phillips PM2.5×6.0 screws (3) that secure the fan and heat sink to
the system board.
NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.
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5.

Remove the fan and heat sink (4).
NOTE: The following illustration shows the fan and heat sink being removed from a computer
model equipped with an AMD processor and a graphics subsystem with discrete memory.

NOTE: The following illustration shows the fan and heat sink being removed from a computer
model equipped with an Intel processor and a graphics subsystem with discrete memory.

NOTE: Steps 6 through 8 apply only to computer models equipped with a graphics subsystem
with UMA memory. See steps 2 through 5 for fan and heat sink removal information for computer
models equipped with a graphics subsystem with discrete memory.
Component replacement procedures
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6.

Disconnect the fan cable (1) from the system board.

7.

Loosen the captive screws (2) that secure the fan and heat sink to the system board. (Computer
models equipped with an AMD processor have three captive screws. Computer models equipped
with an Intel processor have four captive screws.)
NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
system board components, it may be necessary to move the heat sink from side to side to
detach it.

8.

Remove the fan and heat sink (3).
NOTE: The following illustration shows the fan and heat sink removal process on a computer
model equipped with an AMD processor and a graphics subsystem with UMA memory.

NOTE: The following illustration shows the fan and heat sink removal process on a computer
model equipped with an Intel processor and a graphics subsystem with UMA memory.
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NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the heat sink is removed. Replacement thermal material is
included with the base enclosure, fan, heat sink, processor, and system board spare part kits.
Replacement thermal material is also available in the Thermal Material Kit, spare part number
634433-001.
NOTE: The following illustration shows the replacement thermal material locations on a
computer model equipped with an AMD processor and a graphics subsystem with
discrete memory.
●

Thermal paste is used on the processor (1) and the heat sink section (2) that services it

●

A thermal pad is used on the Northbridge chip (3) and the heat sink section (4) that
services it

●

A thermal pad is used on the graphics subsystem chip (5) and the heat sink section (6) that
services it

NOTE: The following illustration shows the replacement thermal material locations on a
computer model equipped with an AMD processor and a graphics subsystem with UMA memory.
●

Thermal paste is used on the processor (1) and the heat sink section (2) that services it

●

A thermal pad is used on the Northbridge chip (3) and the heat sink section (4) that
services it
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NOTE: The following illustration shows the replacement thermal material locations on a
computer model equipped with an Intel processor and a graphics subsystem with discrete memory.
●

Thermal paste is used on the processor (1) and Northbridge chip and the heat sink section
(2) that services them

●

A thermal pad is used on the graphics subsystem chip (3) and the heat sink section (4) that
services it

NOTE: The following illustration shows the replacement thermal material locations on a
computer model equipped with an Intel processor and a graphics subsystem with UMA memory.
Thermal paste is used on the processor (1) and Northbridge chip and the heat sink section (2)
that services them.
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9.

If it is necessary to replace the fan:
a.

Remove the two Phillips PM2.0×3.0 screws (1) that secure the fan to the heat sink.

b.

Release the two clips (2) that secure the fan to the heat sink.

c.

Remove the fan (3) from the heat sink.

Reverse this procedure to reassemble and install the fan and heat sink.
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Processor
NOTE: The processor spare part kit includes replacement thermal material. Replacement
thermal material is also available in the Thermal Material Kit, spare part number 634433-001.
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Description

Spare part number

AMD A8-3500M 2.40-GHz processor (1.5-GHz FSB, 4.0-MB L2 cache, quad core, 35 W)

653350-001

AMD A6-3400M 2.30-GHz processor (1.4-GHz FSB, 4.0-MB L2 cache, quad core, 35 W)

653349-001

AMD A4-3300M 2.50-GHz processor (1.9-GHz FSB, 4.0-MB L2 cache, dual core, 35 W)

653348-001

AMD Athlon II P360 2.30-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core,
25 W)

636635-001

AMD Athlon II P340 2.20-GHz processor (1.0-MB L2 cache, 1066-MHz, 3.2GT/sec, dual core,
25 W)

616343-001

AMD Phenom II N970 2.20-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/sec, quad core,
35 W)

635496-001

AMD Phenom II N870 2.30-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec, triple core,
35 W)

635495-001

AMD Phenom II N850 2.20-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec, triple core,
35 W)

616345-001

AMD Phenom II N660 3.00-GHz processor (2.0-MB L2 cache, 1333-MHz, 3.6GT/sec, dual core,
35 W)

635494-001

AMD Phenom II P960 1.80-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, quad core,
25 W)

634689-001

AMD Phenom II P860 2.00-GHz processor (1.5-MB L2 cache, 1333-MHz, 3.6GT/sec, triple core,
25 W)

634688-001

AMD Phenom II P650 2.60-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, triple core,
25 W)

634687-001

AMD Turion II P560 2.50-GHz processor (2.0-MB L2 cache, 1066-MHz, 3.6GT/sec, dual core,
25 W)

634691-001

AMD V160 2.40-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec, single core, 25 W)

616333-001

AMD V140 2.30-GHz processor (512-KB L2 cache, 1066-MHz 3.2-GT/sec, single core, 25 W)

636634-001

Intel Core i7-2620M 2.70-GHz (SC turbo up to 3.40-GHz) processor (4.0-MB L3 cache, dual core,
35 W)

631252-001

Intel Core i5-2540M 2.60-GHz (SC turbo up to 3.30-GHz) processor (3.0-MB L3 cache, dual core,
35 W)

631255-001

Intel Core i5-2520M 2.50-GHz (SC turbo up to 3.20-GHz) processor (3.0-MB L3 cache, dual core,
35 W)

631253-001

Intel Core i5-2430M 2.40-GHz (SC turbo up to 3.00-GHz) processor (3.0-MB L3 cache, dual core,
35 W)

653341-001

Intel Core i5-2410M 2.30-GHz (SC turbo up to 2.90-GHz) processor (3.0-MB L3 cache, dual core,
35 W)

638039-001
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Description

Spare part number

Intel Core i5-480M 2.66-GHz (SC turbo up to 2.93-GHz) processor (3.0-MB L3 cache, dual core,
35 W)

634693-001

Intel Core i3-2350M 2.30-GHz processor (3.0-MB L3 cache, dual core, 35 W)

653340-001

Intel Core i3-2330M 2.20-GHz processor (3.0-MB L3 cache, dual core, 35 W)

653339-001

Intel Core i3-2310M 2.10-GHz processor (3.0-MB L3 cache, dual core, 35 W)

638037-001

Intel Core i3-390M 2.66-GHz processor (3.0-MB L3 cache, dual core, 35 W)

634692-001

Intel Core i3-380M 2.53-GHz processor (3.0-MB L3 cache, dual core, 35 W)

625823-001

Intel Pentium B950 TJ85 2.10-GHz processor (2.0-MB L3 cache, dual core 35 W)

653338-001

Intel Pentium B940 TJ85 2.00-GHz processor (2.0-MB L3 cache, dual core 35 W)

653337-001

Intel Pentium P6200 2.13-GHz processor (3.0-MB L3 cache, dual core, 35 W)

625831-001

Intel Pentium P6300 2.26-GHz processor (3.0-MB L3 cache, dual core, 35 W)

635500-001

Before removing the processor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 55)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)

●

System board (see System board on page 77)

●

Fan and heat sink (see Fan and heat sink on page 83)

Remove the processor:
1.

Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise (2), until you hear a click.
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2.

Lift the processor (3) straight up, and remove it.
NOTE: The gold triangle (4) on the processor must be aligned with the triangle icon embossed
on the processor socket when you install the processor.
NOTE: The following illustration shows the processor removal process on a computer model
equipped with an AMD processor.

NOTE: The following illustration shows the processor removal process on a computer model
equipped with an Intel processor.
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Reverse this procedure to install the processor.

Display assembly
NOTE: The display assembly spare part kit includes webcam, two microphones, and wireless
antenna transceivers and cables).
Description

Spare part number

17.3-in, HD, LED, BrightView display assembly (includes webcam, two microphones, and wireless antenna transceivers
and cables)
In butter gold finish

640223-001

In charcoal gray finish

640226-001

In luminous rose finish

640225-001

In ocean drive finish

640224-001

In Pacific blue finish

640221-001

In pearl pink finish

640228-001

In pewter finish

640227-001

In Sonoma red finish

640220-001

In sweet purple finish

640222-001

Before removing the display assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47), and then remove the following components:
●

Optical drive (see Optical drive on page 49)

●

Hard drive (see Hard drive on page 51)

●

WLAN module (see WLAN module on page 55)

●

Keyboard (see Keyboard on page 57)

●

Top cover (see Top cover on page 61)
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Remove the display assembly:
1.

Disconnect the display panel cable (1) from the system board.

2.

Release the wireless antenna cables (2) from the clips and the opening in the base enclosure.
CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other
computer components.
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3.

Remove the three Phillips PM2.5×6.0 screws (3) that secure the display assembly to the computer.

4.

Remove the display assembly (4).
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5.

6.

If it is necessary to replace the display bezel or any of the display assembly subcomponents:
a.

Remove the two crew covers (1) and the two Phillips PM2.5×6.0 screws (2) that secure
the display bezel to the display assembly. The screw covers are available in the Display
Screw Kit, spare part number 640218-001.

b.

Flex the inside edges of the top edge (1), the left and right sides (2), and the bottom
edge (3) of the display bezel until the bezel disengages from the display enclosure.

c.

Remove the display bezel (4). The display bezel is available using spare part number
640204-001.

If it is necessary to replace the webcam/microphone module:
a.

Detach and release the webcam/microphone module (1) as far as the webcam/microphone
module cable allows. (The webcam/microphone module is attached to the display enclosure
with double-sided tape.)
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7.
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b.

Disconnect the webcam/microphone module (2) from the webcam/microphone module.

c.

Remove the webcam/microphone module. The webcam/microphone module is available
using spare part number 637197-001.

If it is necessary to replace the hinge covers:
a.

Remove the two Phillips PM2.5×6.0 (1) screws that secure the hinge covers to
the display enclosure.

b.

Remove the hinge covers (2). The hinge covers are available using spare part number
643698-001.
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8.

If it is necessary to replace the display panel:
a.

Remove the four Phillips PM2.5×6.0 screws that secure the display panel to
the display enclosure.

b.

Lift the top edge of the display panel, and then swing it up and forward until it rests upside
down in front of the display enclosure.
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9.

c.

Release the adhesive strip (1) that secures the display panel cable to the display panel, and
then disconnect the display panel cable (2) from the display panel.

d.

Remove the display panel. The display panel is available using spare part number
641395-001.

If it is necessary to replace the display hinges:
a.
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Remove the four Phillips PM2.0×3.0 screws (1) that secure the display hinges to
the display panel.
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b.

Remove the display hinges (2). The display hinges include the display hinges and brackets
and are available using spare part number 640207-001.

10. If it is necessary to replace the display panel cable:
a.

Release the tabs (1) built into the display enclosure shielding that secure the display panel
cable to the display enclosure.

b.

Release the display panel cable from the clips (2) built into the display enclosure.

c.

Remove the display panel cable (3). The display panel cable includes the webcam/
microphone module cable and is available in the Display Cable Kit, spare part number
640205-001.

11. If it is necessary to replace the wireless antenna cables and transceivers:
a.

Release the wireless antenna transceivers (1) from the display enclosure. (The wireless
antenna transceivers are attached to the display enclosure with double-sided tape.)

b.

Release the wireless antenna cables from the clips (2) built into the display enclosure.
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c.

Remove the wireless antenna cables and transceivers (3). The wireless antenna cables and
transceivers are available in the Antenna Kit, spare part number 640192-001.

Reverse this procedure to reassemble and install the display assembly.
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5

Setup Utility (BIOS) and System
Diagnostics

Using Setup Utility
Setup Utility, or Basic Input/Output System (BIOS), controls communication between all the input and
output devices on the system (such as disk drives, display, keyboard, mouse, and printer). Setup Utility
includes settings for the types of peripherals installed, the startup sequence of the computer, and
the amount of system and extended memory.
NOTE: Use extreme care when making changes in Setup Utility. Errors can prevent the computer from
operating properly.

Starting Setup Utility
NOTE: An external keyboard or mouse connected to a USB port can be used with Setup Utility only if
USB legacy support is enabled.
To start Setup Utility, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Setup Utility.

Changing the language of Setup Utility
1.

Start Setup Utility.

2.

Use the arrow keys to select System Configuration > Language, and then press enter.

3.

Use the arrow keys to select a language, and then press enter.

4.

When a confirmation prompt with your language selected is displayed, press enter.

5.

To save your change and exit Setup Utility, use the arrow keys to select Exit > Exit Saving
Changes, and then press enter.

Your change takes effect immediately.
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Navigating and selecting in Setup Utility
To navigate and select in Setup Utility, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of
the screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Setup Utility screen, press esc, and then
follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Setup Utility.
2.

Press f10 to enter Setup Utility.

To exit Setup Utility menus, choose one of the following methods:
●

To exit Setup Utility menus without saving your changes, click the Exit icon in the lower-left corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

●

To save your changes and exit Setup Utility menus, click the Save icon in the lower-left corner of
the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Displaying system information
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1.

Start Setup Utility.

2.

Select the Main menu. System information such as the system time and date, and identification
information about the computer is displayed.

3.

To exit Setup Utility without changing any settings, use the arrow keys to select Exit > Exit
Discarding Changes, and then press enter.
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Restoring factory settings in Setup Utility
NOTE: Restoring defaults will not change the hard drive mode.
To return all settings in Setup Utility to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Setup Utility.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Exiting Setup Utility
●

To exit Setup Utility and save your changes from the current session:
If the Setup Utility menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select Exit > Exit Saving Changes, and then press enter.

●

To exit Setup Utility without saving your changes from the current session:
If the Setup Utility menus are not visible, press esc to return to the menu display. Then use
the arrow keys to select Exit > Exit Discarding Changes, and then press enter.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
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Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Setup Utility.
1.

Start Setup Utility.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Setup Utility without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During
the download and installation, follow these instructions:
Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep or Hibernation.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

Windows 7—Select Start > Help and Support > Maintain.
Windows XP—Select Start > Help and Support, and then select the software and drivers
update.

2.

Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3.

At the download area, follow these steps:
a.

Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive. Make a note
of the path to the location on your hard drive where the BIOS update is downloaded. You
will need to access this path when you are ready to install the update.
NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

104

Chapter 5 Setup Utility (BIOS) and System Diagnostics

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after
the download is complete. If no instructions are displayed, follow these steps:
1.

Windows 7—Open Windows Explorer by selecting Start > Computer.
Windows XP—Open Windows Explorer by selecting Start > My Computer.

2.

Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
the BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete
the downloaded file from your hard drive.

Using System Diagnostics
System Diagnostics allows you to run diagnostic tests to determine if the computer hardware is
functioning properly. The following diagnostic tests are available in System Diagnostics:
●

Start-up test—This test analyzes the main computer components that are required to start
the computer.

●

Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

●

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move
the data to a good sector.

●

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

●

Battery test—This test analyzes the condition of the battery. If the battery fails the test, contact HP
support to report the issue and purchase a replacement battery.

You can also view system information and error logs in the System Diagnostics window.
To start System Diagnostics:
1.

Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.

Using System Diagnostics
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Specifications

Computer specifications
Metric

U.S.

Depth

26.8 cm

10.6 in

Width

41.2 cm

16.2 in

Height

3.1 to 3.7 cm

1.2 to 1.5 in

Weight

2.97 kg

6.55 lb

Dimensions

Input power
Operating voltage

18.5 V dc @ 3.5 A -65 W or 19.0 V dc @ 4.74 A -90 W

Operating current

3.5 or 4.74 A

Temperature
Operating

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity (noncondensing)
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating

-15 m to 12,192 m

-50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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17.3-inch display specifications
Metric

U.S.

Height

21.7 cm

8.54 in

Width

38.4 cm

15.12 in

Diagonal

43.9 cm

17.29 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Dimensions

Pixel resolution
Pitch

0.197 × 0.197 mm

Format

1600 × 900

Configuration

RGB vertical stripe

Backlight

LED

Character display

80 × 25

Total power consumption (varies by display)

2.0 W

Viewing angle

±65° horizontal, ±50° vertical (typical)

17.3-inch display specifications
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Hard drive specifications
750-GB*

640-GB*

500-GB*

320-GB*

250-GB*

Height

9.5 mm

9.5 mm

9.5 mm

9.5 and 7.0
mm

7.0 mm

Length

100.2 mm

100.2 mm

100.4 mm

100.4 mm

100.4 mm

Width

69.9 mm

69.9 mm

69.9 mm

69.9 mm

69.9 mm

Weight

110 g

98 g

110 g

110 g

110 g

Interface type

SATA (3 GB/
sec)

SATA (3 GB/
sec)

SATA

SATA

SATA

Synchronous (maximum)

97 MB/sec

106 MB/sec

1.1 GB/sec

1.1 GB/sec

1.1 GB/sec

Security

ATA security

ATA security

ATA security

ATA security

ATA security

Dimensions

Transfer rate

Seek times (typical read, including setting)
Single track

2.0 ms

1.5 ms

1.5 ms

1.5 ms

1.5 ms

Average (read/write)

12/16 ms

12/13 ms

11/13 ms

11/13 ms

11/13 ms

Maximum

21 ms

24 ms

22 ms

22 ms

22 ms

Logical blocks

1,465,149,16
8

1,250,263,72
8

976,773,168

628,142,448

488,397,168

Disk rotational speed

5400 rpm

5400 rpm

7200 and 5400
rpm

7200 and
5400 rpm

7200 and
5400 rpm

Operating temperature

0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.
NOTE:
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Certain restrictions and exclusions apply. Contact technical support for details.

Chapter 6 Specifications

7

Backup and recovery

Your computer includes tools provided by the operating system and HP to help you safeguard your
information and restore it if ever needed.
This chapter provides information on the following topics:
●

Creating a set of recovery discs or a recovery flash drive (Recovery Manager software feature)

●

Performing a system restore (from the partition, recovery discs, or a recovery flash drive)

●

Backing up your information

●

Recovering a program or driver

Restore
In the event of hard drive failure, to restore your system to its factory image you will need a set of
recovery discs or a recovery flash drive that you can create using HP Recovery Manager. HP
recommends that you use this software to create either a set of recovery discs or a recovery flash drive
immediately after software setup.
If for some other reason you need to restore your system, this can be achieved using the HP Recovery
partition (select models only), without the need for recovery discs or a recovery flash drive. To check for
the presence of a recovery partition, click Start, right-click Computer, click Manage, and then click
Disk Management. If the recovery partition is present, a Recovery drive is listed in the window.
CAUTION: HP Recovery Manager (partition, or discs/flash drive) restores only software that was
preinstalled at the factory. Software not provided with this computer must be reinstalled manually.
NOTE: Recovery discs have been included if your computer does not have a recovery partition.

Restore
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Creating restore media
HP recommends that you create either a set of recovery discs or a recovery flash drive to be sure that
you can restore your computer to its original factory state if the hard drive fails, or if for any reason you
cannot restore using the recovery partition tools. Create these discs or the flash drive after setting up
the computer for the first time.
NOTE: HP Recovery Manager allows the creation of only one set of recovery discs or one recovery
flash drive. Handle these discs or flash drive carefully and keep them in a safe place.
NOTE: If your computer does not include an integrated optical drive, you can use an optional
external optical drive (purchased separately) to create recovery discs, or you can purchase recovery
discs for your computer from the HP Web site. If you use an external optical drive, it must be connected
directly to a USB port on the computer, not to a USB port on an external device, such as a USB hub.
Guidelines:
●

Purchase high-quality DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs.
NOTE: Read-write discs, such as CD-RW, DVD±RW, double-layer DVD±RW, and BD-RE
(rewritable Blu-ray) discs, are not compatible with the Recovery Manager software.

●

the computer must be connected to AC power during this process.

●

Only one set of recovery discs or one recovery flash drive can be created per computer.
NOTE: If you are creating recovery discs, number each disc before inserting into the optical
drive.

●

If necessary, you can exit the program before you have finished creating the recovery discs or
recovery flash drive. The next time you open Recovery Manager, you will be prompted to continue
the backup creation process.

To create a set of recovery discs or a recovery flash drive:
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1.

Select Start > All Programs > Recovery Manager > Recovery Media Creation.

2.

Follow the on-screen instructions.
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Performing a system restore
Recovery Manager software allows you to repair or restore the computer to its original factory state.
Recovery Manager works from recovery discs, a recovery flash drive, or from a dedicated recovery
partition (select models only) on the hard drive.
NOTE: A system restore needs to be performed if the computer hard drive has failed or if all attempts
to correct any functional computer issues fail.
A system restore should be used as a final attempt to correct computer issues. Note the following when
performing a system restore:
●

You can restore only the system that you have previously backed up. HP recommends that you use
HP Recovery Manager to create either a set of recovery discs or a recovery flash drive as soon as
you set up the computer.

●

Windows has its own built-in repair features, such as System Restore. If you have not already tried
these features, try them before using Recovery Manager.

●

Recovery Manager restores only software that was preinstalled at the factory. Software not
provided with this computer must be downloaded from the manufacturer's Web site or reinstalled
from the disc provided by the manufacturer.

Restoring using the dedicated recovery partition (select models
only)
When using the dedicated recovery partition, there is an option to back up pictures, music and other
audio, videos and movies, recorded TV shows, documents, spreadsheets and presentations, e-mails,
Internet favorites and settings during this process.
To restore the computer from the recovery partition, follow these steps:
1.

Access Recovery Manager in either of the following ways:
●

Select Start > All Programs > Recovery Manager > Recovery Manager.
– or –

●

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen. Then, press f11 while the “F11
(System Recovery)” message is displayed on the screen.

2.

Click System Recovery in the Recovery Manager window.

3.

Follow the on-screen instructions.

Performing a system restore
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Restoring using the restore media
1.

If possible, back up all personal files.

2.

Insert the first recovery disc into the optical drive on your computer or an optional external optical
drive, and then restart the computer.
– or –
Insert the recovery flash drive into a USB port on your computer, and then restart the computer.
NOTE: If the computer does not automatically restart in the Recovery Manager, the computer
boot order needs to be changed.

3.

Press f9 at system bootup.

4.

Select the optical drive or the flash drive.

5.

Follow the on-screen instructions.

Changing the computer boot order
To change the boot order for recovery discs:
1.

Restart the computer.

2.

Press esc while the computer is restarting, and then press f9 for boot options.

3.

Select Internal CD/DVD ROM Drive from the boot options window.

To change the boot order for recovery flash drive:
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1.

Insert the flash drive into a USB port.

2.

Restart the computer.

3.

Press esc while the computer is restarting, and then press f9 for boot options.

4.

Select the flash drive from the boot options window.

Chapter 7 Backup and recovery

Backing up and recovering your information
It is very important to back up your files and keep any new software in a safe place. As you add new
software and data files, continue to create backups on a regular basis.
How completely you are able to recover your system depends on how recent your backup is.
NOTE: A recovery from your most recent backup needs to be performed if the computer has a virus
attack or if any major system components fail. In order to correct computer issues, a recovery should
first be attempted before a system restore is attempted.
You can back up your information to an optional external hard drive, a network drive, or discs. Back
up your system at the following times:
●

At regularly scheduled times
TIP: Set reminders to back up your information periodically.

●

Before the computer is repaired or restored

●

Before you add or modify hardware or software

Guidelines:
●

Create system restore points using the Windows System Restore feature, and periodically copy
them to an optical disc or an external hard drive. For more information on using system restore
points, refer to Using Windows system restore points.

●

Store personal files in the Documents library and back up this folder periodically.

●

Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to re-enter your preferences.

To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste. The screen image is added to
the document.

4.

Save and print the document.

Backing up and recovering your information
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Using Windows Backup and Restore
Guidelines:
●

Be sure that the computer is connected to AC power before you start the backup process.

●

Allow enough time to complete the backup process. Depending on file sizes, it may take over an
hour.

To create a backup:
1.

Select Start > Control Panel > System and Security > Backup and Restore.

2.

Follow the on-screen instructions to schedule and create a backup.

NOTE: Windows includes the User Account Control feature to improve the security of the computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

Using Windows system restore points
A system restore point allows you to save and name a snapshot of your hard drive at a specific point in
time. You can then recover back to that point if you want to reverse subsequent changes.
NOTE: Recovering to an earlier restore point does not affect data files saved or e-mails created since
the last restore point.
You also can create additional restore points to provide increased protection for your files and settings.

When to create restore points
●

Before you add or modify software or hardware

●

Periodically, whenever the computer is functioning optimally

NOTE: If you revert to a restore point and then change your mind, you can reverse the restoration.
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Create a system restore point
1.

Select Start > Control Panel > System and Security > System.

2.

In the left pane, click System Protection.

3.

Click the System Protection tab.

4.

Follow the on-screen instructions.

Restore to a previous date and time
To revert to a restore point (created at a previous date and time), when the computer was functioning
optimally, follow these steps:
1.

Select Start > Control Panel > System and Security > System.

2.

In the left pane, click System Protection.

3.

Click the System Protection tab.

4.

Click System Restore.

5.

Follow the on-screen instructions.

Backing up and recovering your information
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Power cord set requirements

the wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC
the 3-conductor power cord set included with the computer meets the requirements for use in
the country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
the following requirements are applicable to all countries and regions:
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●

the length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

the power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

the appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Chapter 8 Power cord set requirements

Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

the Netherlands

KEMA

1

Norway

NEMKO

1

the People's Republic of China

COC

5

South Korea

EK

4

Sweden

SEMKO

1

Switzlerland

SEV

1

Taiwan

BSMI

4

the United Kingdom

BSI

1

the United States

UL

2

1.

the flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2.

the flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

the appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with
the Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

the flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will
be used.

5.

the flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

Requirements for specific countries and regions
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Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! the backlight contains mercury. Caution must be exercised when removing and
handling the backlight to avoid damaging this component and causing exposure to the mercury.
CAUTION: the procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and
the backlight. When you remove these components, handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiai.org.
This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: the procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel (3).

Display
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4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter 2.

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.
15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

Display
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17. Remove the backlight frame from the display panel.

WARNING! the backlight contains mercury. Exercise caution when removing and handling
the backlight to avoid damaging this component and causing exposure to the mercury.
18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
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22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.

Display
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AC adapter light 16
AC adapter, spare part numbers
31, 32
Action keys 11
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locations 14
removal 99
spare part number 28, 35,
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audio-out jack 15
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TouchPad 13
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C
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removal 64
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removal 66
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disconnection 62
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removal 74
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W
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removal 95
spare part number 28, 34, 96
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